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EXECUTIVE SUMMARY

This White Paper provides detailed information about how to migrate multiple user
mailboxes from an IMAP Server to Google G Suite (Apps/Gmail).

It contains recommendations about preparing the Source and Target message
platforms/servers to ensure the proper permissions are in place, which eliminates
the reliance on individual user passwords.

It also provides in-depth information about specific features that alter the default
behavior of Transend Migrator, and identifies best practices that enhance
migration efficiency.

Step-by-step instructions detail how to configure the tool and perform the
migration from beginning to end.

Need more help?

If you can’t find the information you seek, please view the Help File, which contains
the most detailed information about every feature within the tool, including
additional best practices.

Please also contact us directly to get answers to your questions, as well as inform
us of what’s missing in this White Paper — we’re always looking for ways to improve
our offering, and documentation is an important piece of the puzzle.
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IMAP -» Google G Suite
Technical Reference Guide

Section 1: Introduction

This Technical Reference Guide details how to perform a batch migration of the following data types
using Transend Migrator:

» Email Messages/Folders » Calendar Entries
> Address Books » Tasks/To Do Items

For more detailed information about your specific application, security requirements, and additional
migration options, please review the Help File. The Transend Migrator Help File is context sensitive.
Selecting a help button will take you to the specific section in the Help File related to the screen you are
in.

Section 2: User Interface Overview

Transend Migrator contains an easy to use interface, designed to simplify the migration experience
while allowing for maximum flexibility. Setting up your project to convert E-mail, Address Books,
Calendars, and Tasks is accomplished within one user interface allowing you to quickly complete your
migration in one run.

Menu Bar
The Menu Bar is where you will make your data type selections. The top level Menu is where you will

find additional commands for saving configurations, setting various migration options, setting and
viewing logging and reporting options, and setting up batch migrations for multiple users.

.\\ﬁ Transend Migrator - C\ProgramData\ Transend\ default.trd E' [=] @
File Migration Qpticns  Batch Migration View  Edit License Help

ﬁ’ﬁ\ . =
{_“E_’f’.\}\/ E-Mail ‘ g\/ Address Book 5%-"/ Calendar w=|w’ Task/To Do
N ey J
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User Interface
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The same interface is used whether you are migrating a single user mailbox or multiple user mailboxes
at once (Batch Mode). Each screen for E-mail, Address Book, Calendar, or Task/To Do items is similar.

Differences relate to the specific item types. The Email

Configuration screen is shown below.

.\\ Transend Migrator 12 - C\ProgramData\Transend\default_v12.tmd

S

File Migration Options Batch Migration View Edit License Help q

g Address Book
2
Advanced Options...

From: |IMAP Server (Generic)

o
&
&2 E-mail
e

Source

(2]

-

What system should I choose? 3
IMAP Server:
|imap.br0ncos.c0m j
User Name:
|peyton.manning 4

Password:

Folders... 5 (Al folders selected by default)

Start Single Migration... | 10

E-Mail Configuration
Target

EE-I Calendar

i

Task/To Do

-

To: |G00g|e Apps (service acct)
What system should I choose?

&

Google Email Address:
|peyt0n.manning@broncos.com

Optional Service Acct Email:
|589hht@developer.gser\-'iceaccount.com

Optional Private Key File:
|c:\migrate\GUogle-privatekey.lz

Test Logon

Start Batch Migration...

Licensed To: John Elway/Denver Broncos, Inc. for 10000 users

The Top Level Menu is where you set Migration Options, review log
files, configure batch migration data and enter your Iciense information.

The Buttons represent each data type available for migration: E-mail,
Address Book, Calendar, and Task/To Do. You can migrate one or more
data types at a time. Each data type needs to be configured individually
and enabled individually. A green checkmark will appear on the button
when it is enabled for migration.

The Source drop-down menu displays a list of all the available messaging
systems you can migrate from.

After the Source system is chosen, data entry text boxes will display. Fill
out the information required for your source system.

The Folders button allows you to specifically choose or exclude
individual email folders. By default, all folders will migrate. Therefore,
you do not have to configure the source Folders list. This is optional.

10.

The Copy Configuration button allows you to copy configuration
information from the first screen into all other data type configuration
screens. By default, Transend Migrator will fill in the information it can
for you. Once you make changes, then this button allows you to update
the other data type screens with those changes. Only similar or like-
fields will be updated. When you use the Copy Configuration button,
you must re-enable the other data types for migration.

The Target drop-down menu displays a list of all the available systems
you can migrate into.

After the Target system is chosen, data entry text boxes will display. Fill
out the information required for your target system.

Enable the migration after you have configured both the source and
target system by checking the Enable Migration checkbox. Once a data
type is enabled a green checkmark will appear on that section’s button.
Only the Enabled data types will migrate.

Select the Start Batch Migration button when you are ready to proceed
with the migration.
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Section 3: Preparation of Source and Target Environments

Ensuring that you are properly prepared for migration is essential to a successful migration experience.

Time zones
Set the migration workstation to the same time zone as the mail server. Do not use UTC Coordinated
time zone as this may result in incorrect dates/times for migrated items.

Preparing IMAP Server for Migration
The following list contains the basic requirements for migrating from an IMAP Server:

e Convert over a local area network when possible. You can convert over the Internet or a WAN
but the connection speed will be much slower. Sometimes, Internet migrations will cause
excessive timeouts because it is slower or Internet connections are not always reliable. If that
happens then use the /TO <n> switch option. This switch tells Transend Migrator to wait longer
for a response (see help file).

e Your IMAP server could require SSL protection. If this is the case then use the /SSL switch or
enter the secure port on the IP Address or DNS name.

Server Permissions: Administrative Accounts

Normally, you must provide the username and password for each account you are migrating. Some
email servers support an administrative connection method so that the user’s password is not required.
In this method you need to provide the administrator’s credentials through a program option in
Transend Migrator. Then, user accounts can be migrated without their password.

* \e Custermn Options
5 IMAP Option Details
Admin User - Auth External e

Admin User - Authplain Admin User - ProxyAuth

Admin User - ProxyAuth Switch: /PROXYAUTH

Character Set I~ Enabled
Courier IMAP Server
Create TCP DUMP Parameter:

Export Deleted Messages
Extra Text Boundary

Folder Creation _ o
IMAF List Command Use this switch if your IMAP system supports PROXYAUTH. The

two required values are the administrator and its password
(syntax: admin|password).

IMAP Message Number
Interchange Server
Limit IMAP Folders

List Directory i ) )

No Mixed Folders View Enabled Options Clear Enabled Options | 0K
RFCB822 to IMAP Server Search

Selection Criteria Next

Skip Message Type - =
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-
.(\ Custom Opticns

2 IMAP

- Admin User - Auth External
- Admin User - Authplain

- Admin User - ProxyAuth

- Admin User - Auth Exchange
- Character Set

- Courier IMAP Server

- Create TCP DUMP

- Export Deleted Messages
- Extra Text Boundary

- Folder Creation

- Folder Can Contain Period
- IMAP List Command

- IMAP Message Number

- Interchange Server

- Limit IMAP Folders

- List Directory

- Max Bytes

m

Search
( | Next

—Option Details

Admin User - Authplain
Switch: /AUTHPLAIN
[~ Enabled

Parameter: I

Use this switch if your IMAP system supports AUTHPLAIN. The
two required values are the administrator and its password
(syntax: admin| password).

View Enabled Options Clear Enabled Options |

-
K\% Custom Options

- IMAP

- Admin User - Authplain

- Admin User - Authplain

- Admin User - ProxyAuth

- Admin User - Auth Exchange
- Character Set

- Courier IMAP Server

- Create TCP DUMP

- Export Deleted Messages
- Extra Text Boundary

- Folder Creation

-- Folder Can Contain Period
- IMAP List Command

- IMAP Message Number

- Interchange Server

- Limit IMAP Folders

- List Directory

- Max Bytes

—Option Details

Admin User - Auth External
Switch: /AUTHEXTERNAL

[~ Enabled

FParameter:

m

Use this switch if your IMAP system supports AUTHEXTERNAL. The
two required values are the administrator and its password
(syntax: admin|password).

View Enabled Options Clear Enabled Options |

Search
il

MNext

IMAP - Google G Suite
Technical Reference Guide
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Preparing Google G Suite (Apps) for Migration

When migrating to Google Apps or Gmail, you can specify either Google Single User, Google Apps
(service account), Gmail IMAP (service account) or Gmail IMAP (single user). Google Archive can be
used as a source only from Gmail. Under either Single User mode, you must provide a password for that
user. Under both Google (service account) options, you must create a service account in the Google
Developer’s Console and Authorize the service account as the administrator of the Google Apps domain
in Google Admin Console. Under this option, you can migrate all of your users without needing the
password for each Google user account.

Administrative Service Account: OAUTH 2.0

This option implements OAuth 2.0 with the service account option. Once OAuth 1.0 is no longer
supported, this will be the only method of doing a migration using administrator credentials. You will
grant permission to a service account to access your Google Apps data. In most cases this will be a
service account created by you.

For information on how to set up a Google Service Account, view the Creating a Google Service Account
white paper.

Transend Migrator Service Account

Transend has set up an existing service account that will be used by default; however, this opens up a
security hole, since anybody who has Transend Migrator will be able to access your data during the
period that access has been granted to that account. When you run Transend Migrator, this option will
prompt you to supply your service account email, and a pathname of the private key file. Both of these
fields may be left blank, in which case Transend’s service account is assumed.

Note: you still have to grant access to Transend’s service account (email:
24974064516@developer.gserviceaccount.com), and as previously noted, this opens up your data to
anybody with Transend Migrator so it is recommended to setup your own service account with
administrative rights.

For information on how to grant access to Transend’s Service Account, view the Granting Access to the
Transend Service Account white paper.
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To use Google Apps API, configure Transend Migrator as shown with Google Apps (service account)
Enabled the following custom option:
Migration Options>Custom Options>Gmail/Google Apps>Authorization Service Account

You can remove the Optional Service Account Email and Optional Private Key File fields since this
authorization is now enabled in this custom option.

& Transend Migrator 12 - C:ProgramData' Transend}Office365_Google.tmd

File Migration Options Batch Migration Wiew Edit License  Help

. — [ onne chs
.;-_?’\:\/ E-ail ~/ Address Book L?Qp/ Calendar v Task/To Do A
g - . 1. Enter the Google Email Address for the

Advanced Options. ., E-Mail Configuration I¥ Enable Migration :J
(SoLr [Targ user.
@
From; [Office 385 | To: [Gongle spps (service acct) E
What system should I choose? What system should I choose? . . .
Server e e 2. Click Test Login and confirm that you are
outlook office365.com - google 1@isolutionsinc.net| -
User Ernail: Qptional Service Acct Email: H
T —— able to connect to Google after making
Password: Qptional Private Key File:
these updates.
Folders.. (all folders selected by default) Test Logon
3. Click File>Save Configuration
Start Single Migration... Start Batch Migration,..
licensed To: LLaurie JonesyTM 12 For 11 users

Google Single User

If you have selected Google Single User as your source or target system, the first time you perform a
migration, you will be shown a browser window that will allow you to log on to Google. Google will then
ask you for permission to allow Transend Migrator to access your data. Press the Accept button, and the
migration will proceed. The next time you try to migrate the same Google user, no browser window will
be needed, because the authorization key is stored in the registry on your computer. If you try to
migrate a different user, then the same process will be repeated.

File Migration Options  Batch Migration | View  Edit License  Help

PN [y ] i
SN Email v Address Book o Celendar 'J Task/To Do .
v Ly = 1. Enter the Google Email Address

Advanced Options... E-Mail Configuration I Enable Migration i :J f0r the user.
Solrce I _ J e [Target I ‘ ‘ J 9

Fi O 385 “ To: |G Si L ~ H H H

rom; [ofice O o e e T 2. Click Test Login and confirm that
S i ; Google Email Address:
Pt ameeee com | [rogleLGien e ] | you are able to connect to
User Email: .
igooglel@iransend2013.onmicrosoft.com m‘ G00g|e after ma k|ng these
Password:

updates.
Folders... (&l folders selected by default)
3. Click File>Save Configuration
Start Single Migration... Start Batch Migration...

Licensed To: Lauriz Jones/TM 12 for 11 users
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Click ACCEPT to allow Transend Migrator access to the single user data using the user’s login and

password to Google.

e | Transend Migrator | x|
~ Transend Migrator would like to: g

M View and manage your mail
S View your basic profile info
Manage your calendars
B Manage your contacts

@ Manage your tasks
@ Manage your contacts

By clicking Accept, you aliow this app and Google to use your information in
accordance with their respective terms of service and privacy policies. You can
change this and other Account Permissions at any time.

Google Archive

Google allows its users to create an archive of various types of data, including email, calendar, and
contacts, among other types (as of this writing, tasks are not supported). An archive consists of a zip file
containing files in industry standard formats, such as mbox, .ics, and .vcf. Google Archive is a source
option not a target migration option in Transend Migrator.

Transend Migrator works directly with the zip file, saving you the steps of unpacking the file and figuring
out where to store the data, and how to tell Transend Migrator where and what the data is. With this
option, you can select "Google Archive" as the convert-from choice and have it all done automatically.
Using a Google Archive, versus direct access, also has the advantage of allowing Google to compress the
data on its servers before being downloaded. In contrast, if you access email, for example, via IMAP, the
data is not compressed during transfer, and thus the conversion will be slower. In addition, no throttling

(deliberate slowing) is done during a zip file download.
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For information on how to create a Google Archive, view the Creating a Google Archive white paper.

1. Once you have created and downloaded your archive .zip file, you may select "Google Archive" from
Transend Migrator's email, calendar, or address book menus. Specify the name and location of the
.zip file. For mail, you may select which folders to convert. For calendar and contacts, you may
specify which calendar or address book to convert, or accept the default option.

2. Click Browse to locate the downloaded Google Archive zip file.

*-Transend Migrator 12 - C:ProgramData’ Transend',070915_Fxchange?013_Google_IMAPSA.tmd [_ O] x| I

File Migration Options Batch Migration Wiew Edit License  Help

/-/-/\."’\\ n
=/ E-Mail Address Book L_? . Calendar Taszk,/To Do
A b
Advanced Options...l E-Mail Configuration ¥ Enable Migration _J
Source @ Frarget :
From: IGDDgIe archive j To: IExchange,‘Outlookf‘PST {on-premise) j
‘“what systern should I choose? ‘what systemn should I choose?

Google Archive file: Profile, PST or Server Syntax:
IC:\Users\transendadmin\DDwnIoads\takeout'j Browse | Ic:\ost\$Var2.pst j Browse |

Folders... | (all folders selected by default) |F|'—aSSW°rd=

Test Logon |

Start Single Migration... | Start Batch Migration... |

|Licensed T |Laurie Jones{TM 12 for 11 users

3. Click the Copy Configuration button and enable for Email, Address Book and Calendar.

4. Click File>Save Configuration.
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Section 4: Batch Migration Setup

Setting up a batch process is nearly as easy as setting up a migration for a single user account. All batch
data is stored in a Transend Migrator Data (TMD) file which contains all of the settings and options you

have configured within the user interface. Select File | Save Configuration under the main menu to save
all the current configurations to the default.tmd or custom TMD file.

Before configuring and processing a batch migration, we recommend you first test the conversion of one
user mailbox to become familiar with how Transend Migrator operates.

Assigning Batch Variables

Once you have configured and tested a single user mailbox migration, you are now ready to turn your
project into a batch migration by assigning variables to values that can change (usually the mail
database or source user name, password, and target accounts). You assign these variables to values by
populating the Batch Mode Data table.

The Batch Mode Data table is located at Batch Migration | Batch Migration Setup from the main menu.
To perform a batch migration, the Batch Mode Data table needs to be populated with all the users’
account information required for the migration. You provide this information by entering it into each
row and column cell, or by importing a comma delimited text file you have already created. The
information required will vary depending on the email system you use.

e P ﬂ_l_f g;zzfa't'; ;hviitegznlg'rf;;a;:Eg'g}:g:e's
et variables are Svarl through Svar8. The user

Mo g ve  fvea e s pes s eS| gata s populated into the table, and one row
i mesuh i sesh represents one user’s data, and those are
F ones |Jaifer Jores _|fersss | jennifer.jons the values for the variables. Once all the data
||: is entered, select the OK button to return
= back to the main interface and the data type
F you are working on (E-Mail, Address Book,
,': Calendar or Task/To Do). Next, substitute the
o =l user account information with the variables
Current Ling: 4 Load From File.., Load Column From Directory.., Clear Data found on each cqumn header.

Note

The checkboxes are in read-only mode; however, you may right-click on the checkbox and select the
appropriate option. You may also move your cursor to the checkbox field and press the space bar to set
or clear the checkbox.
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Loading User Mailbox Account Data

Load From File: The Load From File button allows you to load a text file, which is a comma separated
value file, of the values you want to fill into the variables columns. In your migration, collect user data
into a database or spreadsheet and then organize the user data by columns and rows. Extract the data
into multiple comma separated value files (CSV) and import those CSV files by batches.

The following CSV file uses the semi-colon as a delimiter instead of the comma. This is useful to use
when a value has a comma, and when the comma cannot be used.

r ~

" Batch001.txt - Notepad =RE X

File Edit Format View Help

gsnuffy;joe.snuffy; -
johnson;bever1¥.johnson;

balbert;blake.albert;

jkrefetz;'ason.krefetz;

mckay; jeff. mckay;

jhieb; john. hieb;

Transend also supports uploading from an Excel Spreadsheet saved as a MS-DOS CSV file.

H ©- B Batch - Exce
FILE HOME IMSERT PAGE LAYOUT FORMULAS DATA REVIEW Nl
sy X - - =

D Calibri AN FE== 8 =3 General
By -

Paste . B I U~ DA =E==E= BH- §$-%

Clipboard Font [F] Alignment [F] Mumber

c2 - F oracle2@transend2013ex.onmicrosoft.com

A B C D E F G H
1 userl 21liEcX0 oraclel@transend2013ex.onmicrosoft.com

2 |user2 UJavaEnioraclezfa'lransendzulsex.onm|crosof't.com
3

S

Load From Directory: The Load Column From Directory button allows you to load file or directory
information into the column of your choice. This feature is helpful when you have migrations based
upon files or directories rather than from direct connections, such as with Exchange/Outlook, Lotus
Notes, and Novell GroupWise.

2y Load Column From Directory
Directory: |C:\Migrate\CaIendars E
Pattern: IT (example: *.nsf, *.pst, etc.) [~ Search Sub-Directories
Column: m
Process Files or Directories?
{* Files " Directories

Load Which Part of File/Directory?
" Entire Path " Name  fiame, fio Biension ¢ Directory Only

oK Help Cancel
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Compare the following two screenshots to see how the variables can be used. The first screen shot
shows the configuration of a single-user email migration. The second screenshot shows how variables
can be inserted into the configuration screen to turn a single-user migration into a batch migration.

Single User Migration

Batch Migration (with Variables)

5y Transend Migrator 12 - CAProgramData\Transend\default_v12tmd

= X

File Migration Options _Batch Migration View Edit License Help

g Address Book

Agvanced Options...
Source @

From: |IMAP Server (Generic) | To:
What system should I choose?

&ﬁ\ L/ E-Mail

?\9 Calendar

E-Mail Configuration W Enabie idration

Target

|Google Apps (service acct) K|
Whet system shouid T choose?

IMAP Server: Google Email Address:
fimap.broncas.com ~| |peyton.manning@brancos.com ~|
User Name: Optional Service Acct Email:

[peyton.manning [ssonht@developer.gserviceaccount.com

Password: Optional Private Key File:
[c:\migrate\Google-privatekey.12
Folders... |  (All folders selected by default) Test Logon
Start Single Migration... Start Batch Migration...
Licensed To: _|John Elway/Denver Broncos, Inc. for 10000 users

Task/To Do
J| Advanced Options...

) Transend Migrator 12 - C:\ProgramData\Transend\default_v12.tmd = X
File Migration Options Batch Migration View Edit License Help
v”-f/\ L/ E-Mail g Address Book ?Q‘ Calendar Task/To Do
-
E-Mail Configuration w Enabie Midration I _J‘
@ Source e Target e
From: |IMAP Server (Generic) K| To: |Google Apps (service acct) |

Wihat system should 1 choose?
IMAP Server:
[imap.broncos.com =

User Name:

[svart
Pasﬂmrd:kx

Fqlders... (Al folders selected by del
I |
No password
required
Start Single Migration...

What system should I choose?
Google Email Address:

[svar2 =

optionMegrvice Acct Email:

[s8ohht@dedegper.gserviceaccount.com
Optional Private Rey, File:

[c:\migrate\Google-prvgtekey.12

Test Logon
Variables defined in
Batch Mode Data table

Start Batch Migration... |

Licensed To: John Elway/Denver Bronces, Inc. for 10000 users

The objective is to look for user data that will remain constant, and user data that needs to change.

Review your data as it is entered in the Batch Mode Data table, and then substitute what needs to
change with the appropriate variable (e.g. Svarl, Svar2, etc.).

Validate Batch Setup

Use this feature to test your batch settings before beginning your batch migration. This feature will test
the logon for each section you specify, and for each user listed in the Batch Mode Data table.

Batch Migration Setup Test

=™ Batch Migration Setup Test

This feature tests the logon function (source and/or target)
for the selected data types.

Source Target
Email 3 I
Address v v
Calendar I3 I
Task ~ I
Start Test Help Cancel

Select the source and target types you want to test the

logon for.
Press the Start Test button.
Review your results.
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Batch Migration Setup Report

Review the Batch Migration Setup Report results. If there are any connection failures, press the View
Log button to review the log file generated during the test.

 ——— =% 1. Pressthe View Report button to view test results. The
Passed Faled report is created in XML, and viewable with Microsoft
Emai Source: ; 0 Excel. It will list each data type tested (email, address
mall Target: .
U . o book, calendar, and task), and will report the success or
LT ! ’ failure of the source and target connection test.
Calendar Source: 4 0
?'ek”:“”“g“' : E 2. Press the View Log button to view the master log file
asi ource:
Task Target: 4 0

generated during the test. The log file is the master log
A detailed report is available in Migration Reports file, and it will show the results of your validation test.
— _— o Review this log file if you have a connection test failure,
and look at the end of the log file for your latest test.
Failures are recorded in red.

Migrated Checkboxes

The first column in each row has a checkbox that tracks which accounts have been successfully migrated
thus far. If the box is checked it means that user has successfully migrated. You can then restart your
migration and only migrate users who do not have a checkmark in the Migrated column.

After a migration is run, all users who were successfully migrated will have their Migrated checkbox
checked. This checkbox information is stored along with the other migration data within the TMD file.
Therefore, it is very important to save the TMD file before and after a migration. When you exit
Transend Migrator after a migration you will receive a warning if you have updated checkboxes and are
attempting to exit without saving.

When you run the same migration again by pressing the Start Batch Migration button, Transend
Migrator will give you the option of converting just the unchecked entries, or to convert them all.

Right click to see the options: View log for record 1, Change Migrated State, Set All Rows to Migrated or
Set All Rows to Not Migrated

; Transend Migrator - Migration Options

Emall Folders | Contact Folders | Calendar Folders | Task Folders | Folder Exclude List | Folder Mapping | Address Transtation |[[gatch tods Data
Batch Mode Data
flox
Migrated | $varl [svarz $varg i' IL—I
~ rnailatransen. nef CH=admin transendadmin/o=cloudapp google 1@isolutionsing. net ? Help
- wiew log for record 1 £2
Change Migrated State
r Set All Rows ko Migrated
- Set All Rows To Not Migrated
I
I
I
It
I
I
I
r B
“ v
Current Line: 1 Load From File Load From Dir. Entity Match.. Clear Data
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Enable Migration

When you are finished inserting the different variables in the appropriate locations, enable the
migration by checking the Enable Migration Checkbox. Notice, the green checkmark will appear on the
appropriate tab after fully configuring and enabling a migration section.

<™ Transend Migrator 12 - C:\ProgramData\Transend\default_v12.tmd | B

File Migration Options Batch Migration View Edit License Help

Y
& EMail g Address Book ?Q‘ Calendar Task/To Do
o o
Advanced Options... E-Mail Configuration I\ J‘

Source @ Target @
From: [IMAP Server (Generic) | To: [Google Apps (service acct) |
what system should I choose? What system should I choose?
IMAP Server: Google Email Address:
[imap.broncos.com ~| [svar2 ~|
User Name: Optional Service Acct Email:
[svart [s89nht@developer.gserviceaccount.com
Password: Optional Private Key File:

[er\migrate\Google-privatekey.12

Folders... |  (All folders selected by default) Test Logon

Start Single Migration... Start Batch Migration...

Licensed To: John Elway/Denver Broncos, Inc. for 10000 users

Copy Configuration

If your migration will include Address Books, Calendars, or Task/To Do items, and those data types will
use the same account information as Email, select the Copy Configuration button to copy your changes
to the other data type sections.

<Y Transend Migrator 12 - C:\ProgramData\Transend\default_v12.tmd | B

File Migration Options Batch Migration View EditLicense Help

B, i
«‘\Jf’_‘;w E-Mail g Address Book ?k}\ Calendar Task/To Do
- ‘=

Advanced Options... E-Mail Configuraticn W Enabie Migration: | J‘

Source 9 Target

From: |IMAP Server (Generic) - To: |Google Apps (service acet) K|

What system should I choose? What system should I choose?
IMAP Server: Gooale Email Address:
[imap.broncos.com - [svar2
User Name: Optional Service Acct Email:
[svar1 |s8hht@developer.gserviceaccount.com /
Password: Optional Private Key File:

[es\migrate\Google-privatekey.12
Folders... (All folders selected by default) Test Logon

h Copy Configuration I

Start Single Migration... Start Batch Migration... ‘

Licensed To: John Elway/Denver Broncos, Inc. for 10000 users

Helpful Hint

It is possible you will want to migrate data that is in a different format as the email system data you are
migrating. For example, you could be migrating email from an IMAP system, but your Address Books are
LDIF files and your Calendar items are VCS files. Transend Migrator is very flexible and configurable to
your unique environment. However, in this situation you would NOT want to use the Copy Configuration
button.
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By default, all available folders will migrate during email conversion. You can change this behavior by
selecting the specific folders you want to migrate or selecting specific folders you want to exclude.

7 Transend Migrator 12 - C:\ProgramData\Transend\default_v12.tmd [ = &J
File Migration Options Batch Migration View Edit License Help
//-\'\
- 7 5
= E-Mall g Address Book { ?5}, Calendar Task/To Do
A 4
Advanced Options... E-Mail Conﬁguratlon  Enable Migration: _J‘
Source @ Target e
From: |IMAP Server (Generic) j To: |G00g|e Apps (service acct) ~
What system should I choose? What system should I choose?
IMAF Server: Google Email Address:
|imap.br0ncos.com j |$var2 j
User Name: Optional Service Acct Email:
|$var1 |589hht@developer.gseNiceaccount.com
Password: Optional Private Key File:

|c:\migrate\GoogIe-privatekey.u

Test Logon

Folders... (All folders selected by default)

Select which folders to migrate,
otherwise all will migrate by default
)
Start Batch Migration...

Start Single Migration... ]

Licensed To:

John Elway/Denver Broncos, Inc. for 10000 users

Folder Convert List

The Folder Convert List is blank by default. When the list is blank this means that all folders available in
the source account will migrate. You may want to press the Load from E-Mail Source button to review
the available folders so that you can manually choose which folders to migrate. Remove a checkmark if

you do not want a specific folder to migrate.

You may also want to load the list of folders into the Folder Convert List so that you can create a list of
folders you do not want to migrate. For example, maybe you do not want to migrate the Junk Mail
folder for one account, or for all accounts. Right click on the folder you do not want to migrate, add it to
the Folder Exclude List, and then press the Clear Data button to remove all entries from the Folder
Convert List. When the Folder Convert List is empty, this tells Transend Migrator to convert all folders

except what is listed in the Folder Exclude List.
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Folder Exclude List

You may want to exclude certain folders from being migrated. Select a specific folder you wish to
exclude, right-click, and then choose the To Exclude List option to copy the folder name to the Exclude
List. This is commonly used in Batch Mode so that a specific folder will be excluded for all accounts. This
is helpful for when you want to migrate all available folders except for a select list. After adding folders
to the Folder Exclude List, remember to clear the list of folders in the Folder Convert List.

| & Transend Migrator - Migration Options

Email Folders | Contact Folders | Calendar Folders | Task Fn\ders' Folder Exclude List  Folder Mapping | Address Translation | Batrh Mode Datal

Felder Exclude List

(Any folder listed here will not convert, regardiess of Corvert List) =
o

*Sparm™ |

Trash

rersnnal Folders* ? Help

il ;I—I

Load From File... Clear Data

1. Enter the names of the folders you wish to exclude.

2. Optionally, if you have a text file containing folder names to exclude you may load that list by
pressing the Load From File button.

3. Right Click in this window for other options on these entries. These Unicode features are helpful

when migrating non-English character sets.

OR

Click Migration Options>Email Convert List

Click Load from Source

Right click and select the folder and select Add to Folder Exclude List

Use the wildcard * to include subfolders

Nouwvas

Page 15 of 33



IMAP -» Google G Suite
Technical Reference Guide

Folder Mapping

Folder Mapping allows you to migrate a folder with a certain name into another folder with a different
name. In many email systems, folders have similar functions yet they have different names. For
example, new messages received into Lotus Notes are placed inside the Notes Inbox folder. In Microsoft
Exchange, new messages received are placed inside the Inbox folder. If you want the Notes Inbox items
migrated from the Lotus Notes Inbox into the Microsoft Exchange Inbox then create a Folder Map.

You may also map to a new folder on the target email system. Enter the new name into the New Folder
Name field and messages specified within the Original Folder Name field will migrate into that folder.

Fa Transend Migrator - Migration Options .
Email Folders | Contact Folders| Calendar Folders | Task Folders | Folder Exclude List [ Folder Mapping Address Translation | Batch Mode Data | Enter the f0|der names by pUttIng your
T cursor into the text box and then begin
Original Folder Name [ew Folder name B A o typl ng.
Corporate Testing 2015/Corporate ? Help
Deleted Items Trash
serl fems —_— Press the Tab key to get to the next
textbox on the list.
Press Shift-Tab to go to the previous
textbox on the list.
Current Line: 4 Load From File... Clear Data
Suggestion

An easy way to load the Original Folder Name is to load the folder list on the Folder Convert List tab,
right click on the folder to be mapped, and then choose the Add to Folder Map menu option. This
feature will copy the folder name into the Original Folder Name textbox on the Folder Mapping tab.

Because the folder names must be exact, adding the Original Folder Name from the Folder Convert List
will ensure it is entered in correctly.

Load From File

You may also create a comma separated value (CSV) file containing a list of Original Folder Names and
the New Folder Name. Save this file as a text file. Load the text file into the Folder Mapping table and
the entries will fill into the Original Folder Name and New Folder Name fields.

Example Map File

=lal=l| The CSV file is a text file with these two values.

File Edit Format View Help

a7 Tbox, Tnbox =l| Each line contains the exact name of the Original

Sent,sent Items

Trash.beleted Items and Target folder name separated by a comma.

Note

If you do not want to map any folders but want to place all folders into a Group Folder, use the Group
Folder switch found in Migration Options | Custom Options. The switch is /GN <value> where value is
the name of the group folder.
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Section 6: Address Translation

Transend Migrator supports address translation through the Address Translation Table. You can access
the Translation Table under Batch Migration | Batch Migration Setup |Address Translation from the
main menu.

The Translation Table allows you to create Internet Style addresses based upon the criteria you provide.
The Translation Table is helpful to use if you are changing the email address of your users and if you
want Transend Migrator to make those changes during the migration. It is also helpful to use when
migrating distribution lists and calendar attendees.

Transend Migrator expects to find a match within the Address Translation Table. Changes will only be
made to matches found.

The Address Translation Table is divided into two sections. The first section is the Old Address format,
and the second section is the New Address format you want it to be. The Old Address section of the
Address Translation Table must be in the exact format the source application stores it.

Translation Table Example
Enter the Address Translation Table data into the fields provided on the Address Translation tab. You

may also import your csv text file containing address translation data into the Address Translation
interface.

‘-Transend Migrator - Migration Options

Email Folders | Contact Folders | Calendar Folders | Task Folders | Folder Exclude List | Falder Mapping ” Address Translation  Batch Mode Data |

Translaton Table

Old Address |New Address ~
googlel@iransend2013.onmicrosoft.com google 1@isolutionsinc.net ? Help |
Current Line: 1 Load From File... | Clear Data |

For more detail about Address Translation refer to the Transend Migrator help file.
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Section 7: Migrating Messages/Folders (Step-by-step)

The following is a step-by-step guide of how to migrate E-Mail from IMAP to Google Apps/Gmail:

1.
2.

o

10.

11.

Select the Email button to configure the email choices.

Select IMAP Server (Generic) from the From drop down box on the Source Pane (left side of the
screen).

Enter the Server Name, User Name and Password (if necessary).

Select the Folders button to choose which folders to migrate. All folders will migrate by default if
no folders are displayed in Email Convert List.

From the To drop down box in the Target pane (right side of the screen) select Google Single
User or Gmail IMAP (Single User) for single user migration. Or use Gmail IMAP (service account)
or Google Apps (service account) to migrate multiple users in batch mode.

Enter the Server Name, Google Email Address, Optional Service Account and Optional Service
Account Private Key file.

Insert the different batch variables in the appropriate source and target locations (if necessary).
Place a checkmark in the Enable Migration Checkbox to enable Email for migration.

Optionally, confgure and enable the other migration choices (Address Book, Calendar, and Task)
if they are to be included with this migration.

Select the Start Batch Migration button to complete the migration. The Migration Monitor will
start and display the real-time migration progress.

Once complete, select the OK button to go back to the main screen.

All options implement the OAuth 2.0 protocol. The only difference is that Transend Migrator
will connect to Google IMAP servers instead of using servers that support the Google http API.
We have found that usually the IMAP service is faster, however it may be subject to throttling,
i.e. a deliberate slow down by Google.
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Section 8: Migrating Address Books (Step-by-step)

If the source email server contains address book information then the address books must first be
exported into a format that Transend Migrator supports. The most common export format is the LDIF
file, which is a text file containing the contact and distribution list entries. LDIF files are ASCII text files
containing directory entries. The format is designed for transferring directories from one system to
another. Once the address book is in the LDIF format then the LDIF can be converted into Google Apps.

The following is a step-by-step guide of how to migrate Address Books from LDIF to Google Apps/Gmail:

1. Select the Address Book Button to configure the Address Book choices.

Select LDIF from the From drop down box on the Source pane (left side of the screen).

3. Enter the path and filename where the address book file is stored or press the Browse button to
choose the file.

4. Select the Folders button to choose which folders to migrate. All folders will migrate by default if
NO folders are displayed in Contacts Convert List.

5. From the To drop down box in the Target pane (right side of the screen) select Google Single
User, Gmail IMAP (Single User) for single user migration. Or use Gmail IMAP (service account) or
Google Apps (service account) to migrate multiple users in batch mode.

6. Enter the Server Name, Google Email Address, Optional Service Account and Optional Service
Account Private Key file.

7. Insert the different batch variables in the appropriate source and target locations (if necessary).

Place a checkmark in the Enable Migration Checkbox to enable Address Book for migration..

9. Optionally, confgure and enable the other migration choices (Email, Calendar, and Task) if they
are to be included with this migration.

10. Select the Start Batch Migration button to complete the migration. The Migration Monitor will
start and display the real-time migration progress.

11. Once complete, select the OK button to go back to the main screen.

N

o

Section 9: Migrating Calendar Entries (Step-by-step)

If the source email server contains calendar information then the calendars must first be exported into a
format that Transend Migrator supports. The most common calendar export format is the vCalendar
(VCS/ICS) file, which is a text file containing calendar entries. Once the calendar information is in the
VCS/ICS format then the VCS/ICS files can be converted into Google Apps.

The following is a step-by-step guide of how to migrate Calendar Entries from vCalendar VCS/ICS files to
Google Apps/Gmail:

1. Select the Calendar button to configure the calendar choices.

2. Select vCalendar VCS/ICS from the From drop down box on the Source pane (left side of the
screen).

3. Enter the path and filename where the .VCS Calendar file is stored or press the Browse button
to choose the file.

4. Optionally, check the Upcoming events only checkbox to convert future items. Enabling this
checkbox migrates only items originally created for future dates.
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Select the Folders button to choose which folders to migrate. All folders will migrate by default if
NO folders are displayed in Calendar Convert List.

From the To drop down box in the Target pane (right side of the screen) select Google Single
User, Gmail IMAP (Single User) for single user migration. Or select Gmail IMAP (service account)
or Google Apps (service account) to migrate multiple users in batch mode.

Enter the Server Name, Google Email Address, Optional Service Account and Optional Service
Account Private Key file.

Insert the different batch variables in the appropriate source and target locations (if necessary).
Place a checkmark in the Enable Migration Checkbox to enable Address Book for migration.
Optionally, confgure and enable the other migration choices (Email, Calendar, and Task) if they
are to be included with this migration.

Select the Start Batch Migration button to complete the migration. The Migration Monitor will
start and display the real-time migration progress.

Once complete, select the OK button to go back to the main screen.

Section 10: Migrating Tasks & To-do Items (Step-by-Step)

Task/To Do items must first be exported into a format that Transend Migrator supports. The most
common calendar export format is the vCalendar (VCS/ICS) file, which is a text file containing Task/To
Do items. Once the Task/To Do items are in VCS/ICS format then the VCS/ICS files can be converted into
Google Apps.

The following is a step-by-step guide of how to migrate Task/To Do Items from VCS/ICS files to Google

Apps/Gmail:

1. Select the Task/To Do button to configure the task choices.

2. Select VCS/ICS from the From drop down box in the Source pane (located on the left side of the
screen), and then enter the required information for your task application.

3. Select the Folders button to choose which folders to migrate. All folders will migrate by default if
NO folders are displayed in Tasks Convert List.

4. From the To drop down box in the Target pane (right side of the screen) select Google Single
User, Gmail IMAP (Single User) for single user migration. Or select Gmail IMAP (service account)
or Google Apps (service account) to migrate multiple users in batch mode.

5. Enter the Server Name, Google Email Address, Optional Service Account and Optional Service
Account Private Key file.

6. Insert the different batch variables in the appropriate source and target locations (if necessary).

7. Place a checkmark in the Enable Migration Checkbox to enable Address Book for migration.

8. Optionally, confgure and enable the other migration choices (Email, Calendar, and Task) if they
are to be included with this migration.

9. Select the Start Batch Migration button to complete the migration. The Migration Monitor will
start and display the real-time migration progress.

10. Once complete, select the OK button to go back to the main screen.
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Section 11: Custom Options

Custom Options are additional settings that allow you to alter the default behavior of Transend
Migrator. All Custom Options are detailed in the Help File.

Select Migration Options | Custom Options from the main menu in order to configure available options.

‘Eustnm Options

3l

[

£

B

- Groupiiise

- IMAP

- Thunderbird Metscape
- MBOX
®-Eudora
[#-Pegasus
[-cc:Mail Archives
(- Other

x|
1 (- Option Detaik
- Exchange/Outiook @
#-Lotus hotes General

enable available options.

Expand each section to review and |

Press these buttons to show all enabled
options or to clear enabled options.

/\

Use the Search feature to find

options. |

* X

View Enabled Options |

Clear Enabled Optinn}/AK |
o

earch

Search Information

If you want to enable an option but do not know where to find it, enter a keyword inside the search text
box to search for the option. Transend Migrator will search for that keyword inside the entire Custom
Options section and display the results.

Select the Next button to review all the sections where your keyword was found. You may also search by
a specific option switch (e.g. /D140). Sometimes an option can be found in two or more locations.
Review the correct location for the option and then enable it in the source or target section related to

your specific project.

Review enabled Options by selecting the View Enabled Options button on the Custom Options screen or
by selecting Enabled Migration Options from the View menu. These choices will display all enabled

options by category.

Commonly Used Custom Options

Custom Option Switch I Description
Installation
Proxy Server /PROXY For license key verificati9n. Internet acce_ss is required. If your network uses a
proxy server then you will need to use this switch.
General
Date Range JUADATE Migrates email, calendars, and task items within a given date range.
Message Date Range /MSGDATE Migrates only messages within a given date range.
Calendar Date Range /CALDATE Migrates only calendars within a given date range.
Set the Max Message Size as 25000 KB’s or 25 MB which is the Office 365
Max Message Size /MAXMSGSIZE limit. If the sum of the attachments causes the entire message to exceed

25000 KB's or 25 MB, the attachments will be removed and replaced with a
text stub.
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Any attachment with a size greater than this value will be removed and

Max Attachment Size /MAXATTACHSIZE .
replaced with a text stub.
Use this switch when the Max Attachment Size switch is enabled. When the
attachment exceeds the maximum attachment size, the attachment will be
Detach Attachments /DETACH placed in.to th.e directory specified by the /DETACH switch. Cr.eate a directory
on the migration workstation called c:\detach and apply a variable so each
user has a directory for attachments, the parameter is specified as
c:\detach\$Varl
Recurring Calendar Entries /D127 Becurring calendar t?nttjigs will appear in the target as true recurring events,
instead of separate individual events.
Recurring Calendar /D179 Forces calendar entries to expand where supported.
entries - Expand
Migrate Unique Messages /DEDUP Migrate unique mgssages and to record the MD5 hash value of the messages
into a new or existing file.
Write the MD5 hash values immediately to the dedup file after each message
Deduping File Writes /D165 instead of writing to memory. This will affect the speed of the migration, but
allows better recovery from a crash.
Deduping Criteria /D56 Only used when the /DEDUP switch is enabled, and it overrides the default
behavior. Choose which fields to run the MD5 Hash algorithm against.
IMAP Specific
Use this switch if your IMAP system supports AUTHEXTERNAL, which allows
Admin User — Auth JAUTHEXTERNAL you t.o migrate user account.s \{vithout the Itleed for a password. The two
External required values are the administrator and its password (syntax:
admin | password).
Use this switch if your IMAP system supports AUTHPLAIN, which allows you to
Admin User — Authplain /AUTHPLAIN migrate user accounts without the need for a password. The two required
values are the administrator and its password (syntax: admin | password).
Use this switch if your IMAP system supports PROXYAUTH, which allows you
Admin User — ProxyAuth /PROXYAUTH to migrate user accounts without the need for a password. The two required
values are the administrator and its password (syntax: admin | password).
. Use this switch for Microsoft Hosted Exchange (BPOS or Office 365). The two
Admin User — Auth . L .
/AUTHEXCHANGE required values are the Administrator and its password (syntax:
Exchange .
admin|password).
SSL /ssL Used for migrating from IMAP or POP3 servers that supports Secure Sockets
Layer (SSL). The port can also be specified (993 for IMAP, 995 for POP3).
Google Apps / Gmail
Enable to migrate bulk users in batch mode without having to use each user
Authorization — Service password. For Google Service Account email, calendar, contacts, or tasks
/XOAUTHSA . . . . . .
Account migrations, specify the service account email and path to P12 key in the form:
service account email address| path to P12 key file
Attachment Rename - /D189 Append “.dat” to file attachments containing “bad” extensions, such as .exe,
Google to prevent Google from rejecting the message.
Logging / Reporting
Adds additional logging to the log file, which is helpful when troubleshooting.
Debug Logging /DEBUG It attempts to log every single step of the migration which causes the log file
to get quite large.
Log Subjects Adds the Subject line information to the tmlog
Log Time Stamps Add the timestamp to the tmlog
Migration Report Level /XMLREPORTLEVEL Use this switch and value to determine the level of detail recorded into the
XML report.
Throttling Options
. Sets the number of seconds the batch mode will allow a migration process to
Maximum Stall Seconds /MAXSTALL be idle for before failing the migration. Default is 180 seconds.
Reconnect /D197 Allows T.ranse.nd Migrator to.reconnect to the server when the tcp/ip
connection fails (the default is 3).
. Increase the Timeout when connecting to the IMAP server (default is 25
Timeout /TO

seconds).
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Message Deduping

Transend Migrator has the ability to prevent duplicate message items from migrating. This feature is
helpful in the event you want to restart a migration, or run a delta. It is also helpful when you restore
many email archives from a particular person, and you want to output only the unique messages.

When deduping enabled, Transend Migrator performs a calculation called an MD5 hash on each
message item to see if it is unique. It writes that the results of the MD5 hash into memory. At the end of
your migration, the MD5 information is taken from memory and written to file.

The calculation is performed on the following metadata items to see if they are unique or different:

e Message Body

e Subject
e Date
e Sender

e Recipient List

These default metadata items can be changed, and you can also add additional requirements such as:

e Folder

e Attachment Header
e Attachment Data

e Unique ID

Enable Deduping:

Select Migration Options from the menu.

Select Custom Options from the sub menu.

Expand the General section to see the section choices.
Enable the section titled, “Migrate Unique Messages”.
Press OK to complete this custom option.

ik wnN e

When no parameter is entered, Transend Migrator will first write the MD5 hash value of each message
into memory, and then write that information into a file called md5.dat, and this file will be created
inside the same directory as the master log file (tmlog.html).

Suggested Deduping Options

Sometimes, a migration will fail and end abnormally. When this happens, the MD5 information in
memory does not get written to disk. Therefore, when this happens you will have some duplicate email
items if you decide to migrate all message folders over again. Therefore, you can force Transend
Migrator to write the MD5 information to disk immediately instead of waiting until the migration is
complete.
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In batch mode, it is common practice to create an md5 hash file for each account migrated. In batch
mode, variables are defined, such as $Svarl, for the name of the dedup file. Often, a variable is a user
name so consider using the user name as the variable. It is easier to keep track of the file if it is related

to the user name, and you will only have to use one variable.

= General | (Option Detail
-Change BCC 9

-Change Quotes
Concurrent Migrations
Create Subdirectories

Date Check - Disable
-Deduping Criteria
-Display 4ll Folders
Filter Messages

grate Unigue Iterms
Deduping File Wirites
-Email Address Algorithm
-Empty Folder Skip
-Bxtract Email Address
Faolder Structure Only
Graup Marme
Hide Passwords

Kl

Create Separate Confact/Cale

Migrate Unique Items
Switch: /DEDUP
¥ Enabled

Parameter: Ic SfeduphgvarLdat

Migrates unique data items and stores the MOS hash value of
each message into the path and filename specified. WARNING: use
a separate file for each user.

Wiew Enabled Cptions Clear Enabled Opfions | oK |

earch

I Mext

& Custom Options

= General

- Change BCC
Change Quotes
Cancurrent Migrations
Create Subdirectories

- Date Check - Disahle

- Deduping Criteria
Display All Folders
Filter Messages
Migrate Unigue Items

- Email Address algorithm

- Empty Folder Skip
Extract Email Address
Folder Structure Only
Group Name

- Hide Passwords

|

& Custom Options []

Create Separate Contact/Cale

[ Option Detail

Deduping File Writes
Switch: /D165
¥ Enabled

Write MDS hash values to dedup file after each message, which
reduces performance but allows better recavery from
acrash,

Clear Enabled Options | oK |

Wigw Enabled Options

earch

I Mext

-1 General

~Change BCC

~Change Quotes
-Concurrent Migrations
-Creata Subdirectories

-Date Check - Disable
-Deduping Criteria
-Display All Folders
Filter Messages
Migrate Unigque Items
Deduping File Writes
Ermnail Address Algorithm
Ermpty Folder Skip
Extract Email Address
Falder Structure Only
Group Name

Hide Passwords

1

-Create Separate Contact/Cale

i

[ Option Detail

@

Deduping Criteria
Switch: /DS
¥ Enabled

Farameter: [BSDNR.

Change default deduping criteria. Used with the /DEDUP switch.
Exarnple: /OS6 BSDNR (see help file for more inforration),

Wiew Enabled Options | Clear Enabled Options | OK |

earch

I\ Mext

F = Folder

B = Message Body

D = Date R= Recipient List

H = Attachment Header (name and length)
A = Attachment Data

S = Subject
N = Sender

U —Unique ID

Note

Turn on deduping by enabling the Custom
Option Setting called, “Migrate Unique
ltems.

Add a path and filename to the
Parameter. Use an existing file or create a
new file. Use the same file if you plan on
deduping between migrations.

Enable the /D165 switch, which is titled,
Deduping File Writes. This switch forces
Transend Migrator to write the MD5 hash
value to disk immediately rather than
after the migration is over.

Optionally, enable the /D56 switch and
then modify the default value, which is
BSDNR. Add at the F value if you want to
include the message folder as part of your
deduping criteria. This might not be a
good idea if migrating from Lotus Notes
and you are migrating views and folders.
This might be a good idea if you are
migrating from another program and you
want duplicate items in different folders.
Perhaps, the folder is important.

Deduping Criteria - Use these parameters
in the Deduping Criteria switch to choose
which fields to run the MD5 Hash
algorithm against

You cannot share the dedup file with another process. Therefore, create a unique dedup file for each account migrated.
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Section 12: Command Line Processing

An alternate way of starting a batch migration is through the command line or with a batch file. Once all
Email, or Address Book, or Calendar, or Tasks sections have been set you normally begin the migration
by pressing the Start Single Migration or the Start Batch Migration button. You may also start a
migration through a command line after saving your configuration using the File | Save Configuration
As... menu choice.

1. Setup a migration project for one user or for a batch of accounts.

Load the user list if you are migrating in batch mode.

3. Save your configuration by selecting File | Save Configuration As... from the main Transend
Migrator screen. Name the configuration file and keep it short. Once have saved your settings
into a configuration file you can then run a batch migration from the command line. Review the
Command Line Syntax & Example section for the command line detail.

N

Command Line Syntax & Example

Syntax TM12.EXE /CMDL /F <path and filename>
Example TM12.EXE /CMDL /F C:\ProgramData\Transend\Project.tmd
TM12.EXE This is the Transend Migrator executable. If you run this command all by itself then Transend

Migrator will start in regular mode.

This switch tells Transend Migrator to run in command line mode. It expects the /F <filename>

/cmbL switch.

The /F switch tells Transend Migrator to perform a migration based upon the settings saved inside

/F <filename> the TMD filename specified.

Additional Options

JCONCURRENT <n> AII_ows_# of conFurrgnt migrations to be set through the command line rather than using the
Migration Monitor interface.

Note

The command line must be executed from the Transend Migrator installation directory. It will be easier
to create a batch file using Notepad rather than manually running it from the command line. Below is an
example of a simple batch file:
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1. Start Transend Migrator and configure the settings for one or more accounts.

2. Save your configuration by selecting File | Save Configuration from the main Transend Migrator
screen. For this example, save your configuration file into C:\Migrate\project.tmd

3. Create a batch file and use the Batch File Example as a guide.

Batch File Example

| Batch001.txt - Notepad (=] s

‘FI|E Edit Format View Help |

gsnuffy; joe. snuffy;
johnson; bever'\%f. johnson;

balbert;blake. albert;

jkrefetz; jason. krefetz;

Jmckay; jeff. mckay;

jhieb; john. hieb;

Run the Batch File

Double-click on the batch file using Windows Explorer. Once the batch file starts it will load the
Migration Monitor and begin migration. When the migration completes the Migration Monitor will exit.

Provide accounts in CSV file

Normally, in a command line migration all your settings and account information is saved in the
Transend Migrator configuration file (TMD); however, you may save the account information inside a
CSV file and reference that CSV file. This is useful when you will be automating the user list extraction
and do not have the ability to save the user information in the TMD file. The CSV file will contain the
values for the variables you define in the TMD file. Use the /batchdata <file> switch in addition to your
other command line switch choices. Any values declared in the TMD file will be replaced, and the values
in the CSV file will be used.

Batch File Example with CSV file containing user information

TM12.EXE /CMDL 1 /F C:\ProgramData\Transend\Project.tmd /batchdata

E
xample C:\Migrate\Userlist.csv

Section 13: Migration Monitor

The Migration Monitor displays the real-time status of all user mailboxes as they are migrated. The
Migration Monitor is a multi-threaded process, which means that multiple accounts can be migrated at
the same time if the email systems support concurrent migrations, and if your license permits.
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Section 14: Concurrent Migrations

Transend Migrator has the ability to migrate more than one account at a time, and this is called
Concurrent Migrations. During a batch process, Transend Migrator will migrate each account in entry
order, which is defined in the Batch Mode Data table. It starts at the top and works through the list until
the list is complete. If your license allows, you may migrate more than one account at a time. This allows
you to complete your project more quickly.

Adjust the number of concurrent migrations when you begin a migration and the Migration Monitor
appears. Transend Migrator will default to 1 concurrent migration. Press the up or down arrow to adjust
the number of concurrent migrations.

Performance

Increase the number of concurrent migrations to attain the best possible speed your system will allow.
Each computer system is different, and each email system is different. Migrating data on a local machine
gives you one rate of speed, while migrating across a local area network will give you a different rate of
speed. The number of email messages and attachments will also affect your migration rate, as will the
size of those messages and attachments.

The best way to determine how fast you can perform a migration is by setting up a few test accounts
and giving each account 1 Gigabyte of normal email data. Migrate one account at a time and review the
rate of speed. Then, migrate the same test accounts and increase the number of concurrent migrations
to 2, and so on. Evaluate the rate of speed and the combined rate of speed. Lower the number of
concurrent migrations when you see a decrease in migration rate

Adding Migration Workstations

At some point, you will reach the maximum capability of your migration workstation, and you may want
to add more workstations to decrease the amount of time it takes to migrate your accounts. Review
how long it takes to migrate 1 GB of data on a single workstation, determine the number of concurrent
migrations your workstation will allow, and then calculate how much faster your project will complete
by adding workstations.

Calculating Migration Time

Below are examples of an easy way to calculate how long it will take to complete a migration. Create a
simple spreadsheet that lists the total number of gigabytes to migrate, the quantity of workstations you
will use, and then the rate of speed your system will migrate. Then, enter a simple formula to calculate
how long your migration will complete with one workstation. In these screenshot examples, your
formula would be: ((Gigabytes/Rate)/PC’s).
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In Microsoft Excel, your formula would look similar to: =(E14/E16)/E15

Number of Days 4.86

Spreadsheet Example 1
| |
! | Item |Description Value !
I e1s 3 Total Quantity of Datato Migrate in Gigabytes 350 !
jet5 4 Quantity of PC's to Process the data 1 i
| B8 5 Gigabytes per Hour 3 |
i Processing Time For Completion In Hours 116.67 |
i

In the spreadsheet example above, it will take 4.86 days to migrate 350 gigabytes of data at the rate of 3
gigabytes per hour. Therefore, you may want to add more machines to complete your project in a
shorter amount of time.

Number of Days 0.97

Spreadsheet Example 2

i i
! | Item |DE§|:riptiun value !
[ 3 Total Quantity of Datato Migrate in Gigabytes 350 [
i 4 Quantity of PC's to Process the data 5 i
| 5 Gigabytes per Hour 3 |
i Processing Time For Completion In Hours 23.33 i
| |

If you are using a simple formula, add more workstations to your spreadsheet to determine how much
faster your project will complete. In Spreadsheet Example 2, the same migration will complete in 23
hours if 5 workstations are used at the same time. Be careful when adding computers to your project,
and verify your source/target servers and network can handle the workload. In you are migrating into
Microsoft Exchange, we recommend you turn off Transaction Logging so that your Exchange Server will
not become overloaded and use up too much disk space. Turn Transaction Logging back on when your
migration project is complete.

Section 15: Schedule Migration

You may schedule a migration to begin at a later time by setting the start time on the Migration
Schedule screen. Start later in the evening when you can receive optimal performance, bandwidth, and
no interruption. If there are other processes that must begin while the migration is running then you
may also pause the migration, and continue after the processes are complete.

You must configure your migration before you can schedule it. Pre-configure the E-Mail, Address Book,
Calendar, and Tasks as they need to be set. Import your list of users if performing a batch migration, and
then save this configuration by selecting File | Save Configuration from the Transend Migrator main
menu.

Caution
Once the schedule has been set it will become effective and begin only after pressing one of the Start

Migration Buttons. Migration will not happen if you close Transend Migrator.

You do not have to set all options in the Migration Schedule. Only the values with an enabled checkbox
will take effect after pressing the Start Migration Button.
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Section 16: Reporting / Logging

Reporting

Migration reports in XML format will be created after each successful run, and can be viewed with
Microsoft Excel. XML reports can be found inside the default subfolder or in a folder containing the
name of the custom configuration, and can easily access by selecting View | Migration Reports from the
main menu. Each time a migration is run a new Migration Report will be created, and it will be assigned
an incremental number beginning with the number 1.

A B C D E F G H | J K
User D Status Database/User Time Started Time Ended Elapsed Time Folder Count Email Count Address Count Calendar Count Task Count
1 Completed pdeex!ljoe snuffy 2/2/3011 18:26:56 2/2/2011 18:28:35 00:01:40 23 1731 1} ] 0
2 Completed pdeex!ljenniferjones  2/2/2011 18:27:38 2/2/2011 18:28:57 00:01:19 23 575 i} 0 i]
3 Completed pdcex!!john.smith 2/2/2011 18:27:39 2/2/2011 18:28:59 00:01:20 16 605 i} 0 i]
4 Completed pdcex!!beverlyjohnson 2/2/2011 18:28:37 2/2/2011 18:28:57 00:00:20 50 91 i} 0 i]

Totals: 112 3002 o i} i}

ol oo e w e

The default detail contained within the XML Report contains the following information:

e UserID e Status

e Database / User ¢ Time Started

¢ Time Ended ¢ Elapsed Time

¢ Folder Count ¢ Email Count

¢ Address Count ¢ Calendar Count

¢ Task Count e Attachment Count

¢ Skipped Entries e Data Rate (megabytes per hour)

Use the following switch and value to increase or decrease the level of detail in the XML Report:

Switch Value Description

Use this switch to disable XML reporting. No XML report will be produced when

/NOXMLREPORT this switch is used.

Use this switch and value to determine the level of detail recorded into the XML
/XMLREPORTLEVEL <n> report. The default value is 1. Increase the value to 2 if you want to record Folder
Names and Entry Counts for those folders.

Note

Transend Migrator reports the number of attachments converted with each message; however please
be aware that this number may include graphic images embedded within HTML documents. Therefore,
the number of actual attachments visible in your email client, such as Word or Excel files, may be
different than reported.
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Logging

Transend Migrator will create a master log file named tmlog.htm/ inside the default system directory.
This log file contains detailed information about the migration session. User specific log files will be
called Tmlog-#.html. The number # will correspond with the specific job number for that user as found
in the Migration Monitor. This file contains detailed information about a specific user. Since the log files
are HTML they are viewable by using your Internet browser. If you want text based log files then use the
JLTEXT switch option located inside the Log File section in Custom Options.

You can find the log files inside one of the following system directories:

Windows XP C:\Documents and Settings\All Users\Application Data\Transend

Windows Vista
Windows 7, 8
Windows 2008 R2

Windows 2012 R2 C:\ProgramData\Transend

Each time you migrate an account, Transend Migrator will create a user specific log file inside a
subdirectory from one of the two system folders listed in the above table. This subdirectory will be
called default, which is the same name as the default configuration TMD file containing all of the
settings and options used in the user interface. If you create custom configuration files the subdirectory
containing user log files will be given the custom configuration’s name rather than default.

The following switches are available to change the way Transend Migrator records information inside
the user specific log files.

Switch Description

JLAP This switch tells Transend Migrator to append to the existing log file instead of creating a new one on
each run.

JLL Use this to create a Summarylog.txt file.

/LNO Use this switch to disable logging. Creating a log is enabled by default.

/LSUB If enabled, each message converted will have its subject added to the log file.

JLTEXT Use this switch to create text log files instead of HTML log files.

/LTS Adds a timestamp value to each line in the log file.
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Section 17: Troubleshooting

General Logon Errors
There are four possible error messages you may receive when attempting to log on to your email
system.

1. Invalid user name or ID: This error generally appears only for IMAP, Outlook, and GroupWise.
Check that you have entered the correct user name, including case and spelling.

2. Invalid password: As above, generally this will occur only with IMAP, Outlook or GroupWise.
Check the spelling, punctuation, and case.

3. Invalid database or directory: This error can occur for systems where it is necessary to identify a
directory where email files may be found. This would include Netscape, Eudora, cc:Mail
archives, EML, and Web. It can also occur for systems where you have to identify a specific
database file, such as a Lotus Notes .nsf file. For Notes, the file must exist in a readable
directory. For the other systems mentioned, assuming that the directory itself exists, the
program is checking for the presence of specific files. For example, the Netscape directory must
have at least one .snm or .msf file. The Eudora directory must have a .mbx file, and the Pegasus
directory must have a .pmm file.

4. Unable to connect with mail system: This is a generic error that can indicate a variety of
problems. Close Transend Migrator and verify the connection with your email client. Use those
same settings when migrating email data with Transend Migrator.

Usually more information is available about a logon problem in the log file. If the error message in the
log file is not helpful, please send a copy to our technical support for further analysis.

Antivirus and Spam Filters

If you have viruses in your email then your antivirus or spam filter might intercept those viruses during
migration. Therefore, it is best to clean your email before or after performing a migration. If the
message is intercepted during migration it could interfere with a successful migration.

If you have antivirus and spam prevention software running on your source or target server, and even
the workstation performing the migration, you will slow down the amount of time it takes to migrate
your data. To improve performance and to decrease the amount of time it takes to migrate your data
turn off antivirus or spam filtering software. Any software designed to intercept email traffic will impede
performance.

Application Violations
These errors can be difficult to troubleshoot but are mostly related to corrupted email messages, or files
that are not email messages but you tried to convert them. If the latter is the case then remove the
offending file.
1. If an application violation (AV) happens then make note of the folder the problem happened in.
2. Enable the /LSUB switch option for logging. The /LSUB switch option will log each message
subject converted (or attempted) into the log file.
3. Attempt an isolated conversion of that specific folder. When the AV happens close Transend
Migrator.
4. Open the Log File with Notepad or alternate text editor.
5. Make note of the last message converted. This will tell you where to look for the problem.
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6. Open the source message account and search for the message subject causing the AV.

Move that message into a TEMP or SAVE message folder.

8. Optionally, move the next message into the same TEMP or SAVE folder. Quite often, it was not
the last message converted that caused the AV. It could be the next one in line. Therefore, this is
why you need to move the next one into the TEMP or SAVE message folder.

9. Begin another migration, but this time skip the TEMP or SAVE message folder. When the
migration is successful you can continue on. You will have successfully identified the corrupted
or problem messages.

N

Microsoft Outlook

Microsoft Outlook must be the default email system for Windows when migrating Outlook email data.
At least one profile must be created so that Outlook will set itself up for your email environment. Once
this is done then no other profiles are needed if using the special syntax to access accounts directly.

You do not need a profile to migrate multiple Exchange accounts. Profiles are not required. But, your
Windows account must have permissions to access the account you are accessing. Contact your
Network Administrator to gain access to other people’s email accounts. If you are performing migrations
for selected Exchange users then you must be granted RECEIVE-AS permissions on the mailbox to be
migrated.

When you are using the Transend Migrator graphical User Interface you can migrate other people’s
email accounts as long as you have created a profile for that user, and have the login ID and password
for that user. This is not the recommended method. The recommended method is to be granted access
permissions so that a password is not needed and so that a profile is not needed.

If you are migrating multiple users and/or will be using the Batch Mode Processor then give your

Windows account (the account or group doing the migration) the RECEIVE-AS permissions on the
Mailbox Database for your Exchange Server.
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Section 18: Technical Support

Technical support is available to help you understand how to use Transend Migrator with your migration
project. Please review the Help File and online resources before contacting technical support.

You are encouraged to submit questions through email. This will allow us time to properly research your
situation and make appropriate recommendations.

Note: Transend’s normal business hours are M-F, 9am — 5pm (Pacific). If you will be performing a
migration during non-business hours, and anticipate a need for support during non-business hours,
please contact us at least 7 days in advance so we can schedule a support engineer to be available, if
possible.

Sending Log Files to Transend Technical Support

It is important to include a copy of your log files when submitting a support request. You may send the
log files individually, or send the log files using the Email Log Files menu feature from the Transend
Migrator interface using the following procedures:

“\ProgramData\Transend\default.tmd

Contents /
viail g Address Bou Email Log Files 5
About..
E-Mail Configuration | Enable Migration

— Taroet

Select Help>Email Log Files from the menu list. Transend Migrator will attempt to open your default
email program and then create a new message similar to the example, below.

4 To... tech.suppor tStr ansend.com
SE08, e

Account = | Subject: | Transend Migrator log files from Johin Hieb/Transend Corporation

IMPORTANT: you must manually attach this file:
C:\Users\john. hieb\Decuments\Transend_Logfiles.zip |

Enter any further information below:

Notice

The path to the log file package (a zip file containing your log files, report, and settings file) will be
inserted into the body of the email message. In the example, the log file path and filename is at
C:\Users\john.hieb\Documents\Transend_Logfiles.zip. Your path will be similar. Using your email
program, insert the log file package. Use the path and filename listed in your email message.

Before contacting technical support, we recommend that you are using the current patches or service
packs for your hardware, your operating system and software. Also, download the latest version of
Transend Migrator from www.transend.com. Review the What’s New section of the Transend web site
to review the latest release information.

Email: tech.support@transend.com.
Phone: (650) 324-5370
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